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Dear SOMATOM user, 
We would like to present you our application guide for 

clinical applications. To improve future versions of this 

application guide we would highly appreciate your 

questions, suggestions, and comments. The informa-

tion presented in this application guide is for illustra-

tion only and is not intended to be relied upon by the 

reader for instruction as to the practice of medicine.

Any health care practitioner reading this information is 

reminded that they must use their own learning, train-

ing, and expertise in dealing with their individual 

patients. This material does not substitute for that duty 

and is not intended by Siemens Medical Solutions Inc., 

to be used for any purpose in that regard.

The drugs and doses mentioned are consistent with 

the approval labeling for uses and/or indications of the 

drug. The treating physician bears the sole responsibil-

ity for the diagnosis and treatment of patients, includ-

ing drugs and doses prescribed in connection with 

such use. The Operating Instructions must always be 

strictly followed when operating the MR/CT System. 

The source for the technical data is the corresponding 

data sheets.

The pertaining operating instructions must always be 

strictly followed when operating a SOMATOM scanner. 

The statutory source for the technical data are the cor-

responding data sheets. We express our sincere grati-

tude to the many customers who contributed valuable 

input.

Special thanks to Clara Soulie, Christiane Schindler,  

Christiane Bredenhöller and Kristin Pacheco for their 

valuable assistance. 

Please contact us: 
USC-Hotline: Tel. no. +49-1803-112244 
email: ct-application.hotline@med.siemens.de 
Editor: Ute Feuerlein
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❍ Standard

● Option

– not available

depending on the system configuration.

Please contact the local Siemens representative for  
further information.

syngo 

3D

syngo 

VRT

syngo 

Fusion

SOMATOM Sensation 64 ● ❍ ❍

SOMATOM Sensation 40 ● ❍ ❍

SOMATOM Sensation Cardiac 64 ● ● ❍

SOMATOM Sensation Open ● ❍ ❍

SOMATOM Emotion 6 ● ❍ ❍

SOMATOM Emotion Duo ● ❍ ❍

Matrix
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syngo 

Fly Through

syngo 

Colonography

syngo 

InSpace4D

syngo 

VesselView

❍ ❍ ❍ ❍

❍ ❍ ❍ ❍

❍ ❍ ● ●

❍ ❍ ❍ ❍

❍ ❍ ❍ ❍

❍ ❍ ❍ ❍
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User Documentation

For further information about the basic operation, 

please refer to the corresponding syngo CT Operator 

Manual:

syngo CT Operator Manual Volume 1:

Security Package

Basics

SOMATOM LifeNet

syngo Patient Browser

syngo Data Set Conversion

Camtasia

SaveLog

syngo CT Operator Manual Volume 2:

Preparations

Examination

HeartView CT

Respiratory Gating

CARE Bolus CT

CARE Vision CT

syngo Viewing

syngo Filming

syngo CT Operator Manual Volume 3:

syngo 3D

syngo InSpace4D
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syngo CT Operator Manual Volume 4:

syngo Dental CT

syngo Osteo CT

syngo Volume

syngo Dynamic Evaluation

syngo Neuro Perfusion CT

syngo Body Perfusion CT

syngo CT Operator Manual Volume 5:

syngo Argus

syngo Calcium Scoring

syngo Vessel View

syngo CT Operator Manual Volume 6:

syngo Colonography

syngo LungCARE CT

syngo Pulmo CT
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Application Information

Image Converter

The CT Application Common DICOM Adapter pro-

vides conversion between different DICOM data sets as 

they may be provided by other CT vendors.

– You will find the converter in the Applications menu 

of the Patient Browser.
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In the pop-up window you can select for which appli-

cation you want to convert the images.

Split-up multi-phase series

1.Select Split-up series according to trigger delay 

from the section Split-up Heartview 4D series, if 

you intend to split-up the series of multi-phase heart 

reconstruction according to the different heart 

phases included. 

Or

2.Select Split-up series according to slice position to 

split-up the series according to the different slice 

positions it contains. 

After conversion you can load these data sets in the 

application of your choice.
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Application Information

Report Template 
Configuration

Under Options > Configuration... you will find the 

Report Configuration.

With the Report Configuration you can edit the basic 

information, e. g. hospital information for your report 

templates of the applications:

– CalciumScoring

– Colon

– LungCARE

Additionally you can insert your logo and select which 

reference data you want to use.
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File Browser

The File Browser provides you with a secure possibility 

for accessing and managing data in a private folder, 

which is a well defined part of the file system. This user 

partition is strictly separated from the file system con-

taining.

The user partition is shared read only and may be used 

for transferring data from the scanner to other com-

puters, e.g., transferring DICOM images (export to 

offline), transferring AVIs, or accessing files (PDF files) 

which were downloaded via SOMATOM LifeNet.

Key features

• Copy images and files to the CD Burn folder

• Access to all created reports and movies (AVI files)

• Access to the Offline folder

• Access to downloaded files

Open the File Browser via main menu entry 

Options > File Browser.

The File Browser provides special folders for our appli-

cations. Therein, the created reports and movies are 

saved.

With an external PC connected you can access your 

offline data on the external PC for post-processing.

Transfer files to floppy:

– Select the desired files and send them via the right 

mouse button menu on a floppy disk.
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Application Information

Burn on CD:

– Do not burn files on CD-R parallel to other transfer 

jobs.

– Make sure that the amount of data to be burned 

does not exceed the CD-R storage capacity.

– Select the desired files and drag & drop them into the 

folder Burn on CD (or send them via the right mouse 

button menu to the folder Burn on CD).

– Open the LocalJobStatus in the Patient Browser 

and clear all entries.

– Select Record to Offline in the Transfer menu of the 

Patient Browser.

– CD burning starts.

– Hint: CD burning of offline files is only possible in 

Single session.
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Review reports and movies:

– Select the desired files and double-click on them.

– The corresponding program, e.g. Movie Media Player 

will be opened and you can review what you have 

saved.

– Now you can send these files to floppy or burn it on 

CD.

Hint

Files with the following extensions cannot be started/

opened from the FileBrowser 
“.bat“, “.cmd“, “.com“, “.exe“, “.reg“, “.dot“, “.htm“, 

“.html“, “.pl“, “.vbs“, “.js“, “.wsf“, “.wsh“, “.xml“ 
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syngo 3D

Key Features

The 3D card offers the ability to combine two-dimen-

sional images to form three-dimensional views.

To do this, the 3D card provides you with the following 

methods:

Multi Planar Reconstruction (MPR)

Interactive navigation through 3D volumes in arbitrary 

orientations.

• Orthogonal, oblique or double-oblique orientation.

• Easy scrolling through 3D volume data set.

• Real-time reconstruction of secondary slices.

• Additional diagnostic information, e.g. with sagittal 

or coronal reconstructions from axial images.

• Variable slice thickness (MPR Thick, MPR) and dis-

tance with configurable default values.

• Calculation of arbitrarily curved cuts.

Maximum Intensity Projection (MIP)

Angiographic display.

• Projection of pixels with highest intensity (vascular 

information) onto an arbitrarily oriented plane.

• Display of e.g. aneurysms, plaques, stenoses and 

other vascular anomalies.

• MIP Thin function for projection within a small slab 

to focus on particular vascular structure.
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Shaded Surface Display (SSD)

Surface display of complex anatomies.

• 3D display of surfaces from a series of contiguous 

slices using a variable threshold.

• The displayed volume consist of voxels whose HU are 

in a range defined by two limit values, an upper and 

a lower threshold (= HU limits). 

• Display and analyze various anatomies, e.g. from the 

cranium, pelvis, extremities, e.g. for the purpose of 

planning surgical interventions.

• The 3D objects can be tilted and rotated in real-time.

Volume Rendering Technique (VRT)

True 3D visualization of volume data.

• Projection onto an arbitrarily oriented plane.

• Density, opacity and refraction information is used to 

generate views that optimally meet different clinical 

objectives.

• Optimal display quality and differentiation of differ-

ent organs through independent control of color, 

opacity and shading in up to 4 tissue classes.

• Predefined settings for many clinical objectives and 

anatomic regions are easily selected from an image 

gallery.

• Pre-settings can be linked to DICOM series descrip-

tion to automatically ensure standardized quality in 

clinical routine.

• Clip-planes can be used to easily scroll through the 

volume in VRT Thin mode.

• Easy interaction with SmartSelect control (right 

mouse button).
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syngo 3D

Prerequisites

At least 3 and maximum of 1600 images must have 

been loaded to process 3D; (with more than 1600 

images the series will be split up). All images must 

have the same x/y coordinates, FoV and gantry tilt.

• You should close all data sets in any of the other task 

cards that you no longer need in order to release 

memory space and maintain application perfor-

mance.

• CT volume data sets are best acquired with overlap-

ping thin slice CT technique.

• Use only axial images.
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syngo 3D

Workflow

Loading the Images

After loading the images into syngo 3D the following 

layout is displayed:

1 2

3 4
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Image Representation on the 3D card

The image area on the 3D task card is divided into four 

segments:

The first three segments are reference segments, the 

fourth segment is an output segment. In the three ref-

erence segments the images are first shown in the 

views that are parallel and perpendicular to the direc-

tion of scanning.

1.Reference segment (sagittal view)

2.Reference segment (coronal view)

3.Reference segment (axial view)

4.Output segment

By turning and moving the views you can define the 

position and orientation of the plane that is to be used 

as the reference image for the reconstruction of 

images or series.

The reference segments are used to display different 

views of the volume data set, while the reference dis-

play (the view) is used as a reference for a 3D-recon-

struction.

The images and series generated by various tools on 

the basis of the reference image are displayed in the 

output segment.
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To find the best suitable reference image for planning 

reconstruction of images and series, you can freely 

rotate and move all three views.

The reference image is used as a reference for a 3D-

reconstruction, while the other views are used to dis-

play different views of the volume data set.

The generated images and series are displayed in the 

output segment.
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Defining Output Types

You can change the output type for a segment at any 

time, i.e., from Multi Planar Reconstruction (MPR) to 

Maximum Intensity Projection (MIP), to Shaded Sur-

face Display (SSD), or to Volume Rendering Technique 

VRT).

Depending on your workflow method, you will first 

generate a reference image, for example, in MPR in the 

desired view and then switch to MIP, SSD or VRT dis-

play.

• Click on the segment for which you want to change 

the out-put type.

• If you want to switch over all segments, you must 

select and switch over each one separately, one after 

the other.
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syngo 3D

Creating Series

This application gives you the ability to easily create 

new images or even image series, e.g. for a fast display 

of anatomical interesting structures

• With any slice thickness (at least the reconstructed 

slice thickness)

• Variable distance/angle between the images

• Selectable number of images

• Selectable range of reconstruction

• Different output types

Parallel Ranges

With this option you generate a series of cut images 

that are parallel to one another and perpendicular to 

the reference image for the output types MPR, MPR 

Thick and MIP Thin.

For example, for MPRs or MIP Thin through a process in 

the lung or abdomen.
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Radial Ranges

For output types MPR, MPR Thick and MIP Thin you 

generate a series of cut images arranged in a star 

shape.

For output types MIP, SSD and VRT you generate a 

series of projections and views of the volume each 

rotated around a defined angle. In this way, you simu-

late a step-by-step rotation.

For example, for colored VRT images, showing a pro-

cess from different angles.

Expanded Ranges

With this option you generate images that are located 

in front of or behind the reference image. This option, 

too, is only available for output types MPR, MPR Thick 

or MIP Thin.

For example, for MPRs or MIP Thin through a process in 

the lung or abdomen.

Curved Ranges

If you want to view sub-areas that cannot be obtained 

by planar, i.e., flat images, you can draw a cut line with 

any curvature freehand. This cut will then be shown as 

an image/series in the output segment.

For example, for MPRs or MIP Thin from the aorta or 

the peripheral arteries.
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Editing

A common problem in evaluating medical images is 

that areas relevant to an examination are hidden by 

other structures, especially bones. The necessary 

image information is contained in the volume data set 

but must be made visible with suitable editing steps.

1.VOI mode: With a Volume of Interest (VOI), you 

extract a volume of diagnostic interest by limiting 

the volume to be reconstructed to a partial volume.

You can extract a VOI (volume of interest) in one of the 

following ways:

• Position and differentiate a cuboid VOI (VOI clipbox)

• Draw a freehand VOI (VOI Punch mode)

2.Clip planes: Clip planes can also be used for hiding 

parts of the data set.

Sometimes it is useful to use only a part of the volume 

for projection. The sub area is defined by the two par-

allel intersection planes (“separation plane“). The dis-

tance between these planes is the slice thickness to be 

defined. For example, you can avoid cutting out inter-

fering structures; (MIP Thin, VRT Thin/clip).



syngo 3D

29

 

3.3D Object Editor: Easy elimination of obstructing 

information.

• Easy volume confinement with clip-box or variable 

editing slab.

• Fast object creation with threshold operations or 

automatic volume growing.

• Multiple editor objects can be displayed with differ-

ently colored SSD.

• Complete object subtraction with dilatation and ero-

sion functions.

• Remaining volume data set after object subtraction 

can be displayed with all 3D representations, i.e. 

VRT, MPR, MIP or SSD.

With the 3D Object Editor you can perform the follow-

ing operations:

• Object generation with Region Growing

• Object management in the object list

• Object editing with Object Punching and 
Morphological Operations

Region Growing

Normally in the first step you will generate one or 

more “objects“ from the volume data set originally 

loaded in 3D. By specifying a limited voxel value range 

you extract only a section of the voxels from the origi-

nal data set. In this way, you generate an object in the 

result segment.

Instead of extracting globally from the entire volume 

data set you can also proceed “slice by slice“ (in 3D 

blocks) using the Slab Editor.
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You can also set Seed Points in the original data set, 

thus limiting the creation of an object to defined 

regions which are also connected to one another in the 

specified voxel area.

Object Punching

Like editing volume data sets in the VOI mode, you can 

use the 3D Editor, too. You are provided with tools for 

cutting out structures from an object that you have 

previously generated.

Using the Slab Editor you can define your own cutting 

depth.
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Morphological Operations

In some cases it will not be simple to separate the 

structures of an object using the cutting tools. Here we 

recommend eroding, or shrinking, the areas of the 

object by a specified surface thickness until the obscur-

ing structures are no longer contained in the object.

You can subsequently dilate, or blow up, the remain-

ing object areas by a defined surface thickness. As a 

result, the irrelevant areas contained at the outset are 

now removed from the representation.

If you perform the same operations in reverse order, 

small cavities in the object will be filled.

Documentation of Results

The buttons Copy to Film sheet and Save/Save As are 

always available. You can always document intermedi-

ate results by these buttons.

To save images you have following possibilities:

• Storing the new series automatically during recon-

struction

• The Save button will store the image/series with no 

further check

• The Save as button will give you the possibility to 

choose a name for the new the image/series before 

storing



32

 

syngo 3D

Case Examples

Workflow for a CT Extremity 

Examination

Using MPR/MPR Thick

1.Load the series to MPR.

2.Manipulate the volume to evaluate anatomy:

a)Orientate the image volume for the best view of 

the anatomy.

b)Adjust the window as necessary.

c) Pan and zoom image as necessary.

3.Scroll through the volume quickly using the 3D 

cross-hair or dog-ears to gain a three-dimensional 

impression.

4.The minimum slice thickness of an MPR image is one 

voxel, but you can generate thicker slices (MPR 

Thick) for easier evaluation.

5.Measure, annotate and document as needed.

6.Optionally, create image series using parallel, 

expanded or curved ranges and output them either 

on a film or save them to database.
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Using SSD

1.Load the series to SSD. 
Hint: Do not use a series with a high resolution ker-

nel, e.g. kernel 10 or 20 is recommended.

2.Manipulate the volume to evaluate anatomy:

a)Orientate the image volume for the best view of 

the anatomy.

b)Adjust the threshold as necessary.

c)Pan and zoom image as necessary.

d)To eliminate unwanted structures use VOI punch-

ing/3D Object Editor.

3.Measure, annotate and document as needed.

4.Optionally, create image series using radial ranges 

and output them either on a film or save them to 

database.

Using VRT

1.Load the series to VRT.

2.Manipulate volume to evaluate anatomy:

a)Orientate the image volume for the best view of 

the anatomy.

b)To eliminate unwanted structures either activate 

VRT Thin/clip or use VOI punching/3D Object 

Editor.

c)Select VRT preset from VRT gallery.

d)Adjust window, opacity, color and lighting effects 

as necessary.

e)Pan and zoom image as necessary.

3.Measure, annotate and document as needed.

4.Optionally, create image series using radial ranges 

for VRT; parallel, expanded or curved ranges for VRT 

Thin/clip and output them either on a film or save 

them to database.
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Workflow for a CT Angiography

Using MIP/MIP Thin

1.Load the series to MIP.

2.Manipulate the volume to evaluate anatomy:

a)Orientate the image volume for the best view of 

the anatomy.

b)To eliminate unwanted bone either activate MIP 

Thin or use VOI punching/3D Object Editor.

c) Adjust the window as necessary.

d)Pan and zoom image as necessary.

3.Measure, annotate and document as needed.

4.Optionally, create image series using radial ranges 

for MIP; parallel, expanded or curved ranges for MIP 

Thin and output them either on a film or save them 

to database.
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Using VRT/VRT Thin/clip

1.Load the series to VRT.

2.Manipulate volume to evaluate anatomy:

a)Orientate the image volume for the best view of 

the anatomy.

b)To eliminate unwanted bone either activate VRT 

Thin/clip or use VOI punching/3D Object Editor.

c)Select VRT preset from VRT gallery.

d)Adjust window, opacity, color and lighting effects 

as necessary.

e)Pan and zoom image as necessary.

3.Measure, annotate and document as needed.

4.Optionally, create image series using radial ranges 

for VRT; parallel, expanded or curved ranges for VRT 

Thin/clip and output them either on a film or save 

them to database.
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Additional Important 
Information

Setting Views in the Volume Data Set

Three-dimensional image processing allows you to cre-

ate images in any orientations and positions within the 

data volume.

You can “move“ through the volume and rotate it in any 

direction. Depending on the method you are using, 

various aids are available to you.

Rotating around one axes (oblique cut planes)

For oblique slices, you rotate a slice about one axis of 

the patient coordinate system starting from the stan-

dard view.

The orientation is displayed in the image as a combina-

tion of two orientation labels.

One of the two reference lines in the image is now dot-

ted. The corresponding plane is therefore oblique in 

relation to the displayed image.



syngo 3D

37

 

Rotating around two axis (double-oblique cut planes)

You obtain cut planes in two axes whenever you rotate 

one slice around two different patient coordinate axes 

one after the other.

The plane is then no longer perpendicular to either of 

the coordinate axes. The image orientation is dis-

played as a combination of three orientation labels.

➭ The subtask card Orientation will always give you 

the ability to return immediately back to the begin-

ning or to any standard view.

➭ View perpendicular to reference image (Ortho 

Sync). Usually, you activate the orthogonal view to 

display slices along the main axis of an organ, e.g., 

the heart.
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Changing /Creating VRT Presets

You will use the Volume Rendering Technique (VRT) to 

obtain more precise representation and separation of 

tissue types. To highlight certain aspects of the ana-

tomical region, you can change the color, brightness, 

and transparency of different areas.

As display parameters for the VRT view, customary 

default settings are stored on your system in the VRT 

gallery.

If the default settings are not appropriate for your diag-

nostic problem, you can alter them individually. In that 

way you can emphasize the structures of interest in an 

optimum way.

➭ Ramp and trapezoid manipulation: Ramps and trap-

ezoids are functions which define window and ren-

dering settings. Trapezoids can also be used to differ-

entiate a tissue classification range (e.g. bone versus 

soft tissue in a CT image).

➭ Change rendering settings using the table classifier 

trapezoids. Moving the ramp changes the window 

width and center. Opacity and brightness can be 

adjusted to optimize organ-specific settings.

➭ Lighting to enhance 3D. The mouse cursor is used to 

define the direction of incident light.

➭ VRT presets can be stored in the VRT gallery and 

linked to specific series description.
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Auto Load in 3D and Postprocessing 

Presets

Automatic generation of parallel (MPR, MIP Thin) or 

radial cuts (MPR, MIP, SSD, VRT) for subsequent image 

reading.

You can activate the Auto load in 3D function on the 

Examination card/Auto Tasking and link it to a recon 

job. If the post-processing type is chosen from the pull 

down menu, the reconstructed images will be loaded 

automatically into the 3D card on the Navigator with 

the corresponding post-processing type after the 

reconstruction.

On the 3D card you have the ability to create Range 

Parallel and Radial protocols which can be linked to a 

special series names.

➭ Select the image type

➭ Select the orientation

➭ Open the Range function and adapt the range set-

tings (Image thickness, Distance between the 

images etc.)

➭ Hit the link button

➭ Save the linked preset
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Blow-up Mode

Full screen display by double-clicking in the segment 

for easier visualization.

Zooming factor

The zooming factor for the reference image display is 

automatically selected in order to display the complete 

volume.

This preselected zooming factor influences the spatial 

resolution for reconstruction which may be lower than 

the spatial resolution of the original images. 

• Zoom and move the FoV (Field of View) before start-

ing the reconstruction to achieve an appropriate spa-

tial resolution for the resulting reconstructed image.

Changing the threshold definition of 

SSD

When changing the threshold definition of SSD 

(Shaded Surface Display), all segments containing SSD 

images will reflect your threshold changes.

If no segment with SSD is available, the active segment 

will be used instead.
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Presentation of 3D images

Presentation of 3D images in an anatomical orienta-

tion can be achieved by using the function Orienta-

tion Control.

This function is located at the upper part of the 3D task 

card or in the Options menu bar.

If this function is active, complete upside down rota-

tions are not possible. The image flips back to an 

upward position if rotation is greater than 135° from 

upward- or supine orientation. 

• Press the button before starting range planning.

If the function Orientation Control is invoked during 

range planning, the functionality is still active at the 

time the next image will be generated, e.g., when 

range calculation is started or orientation is changed.
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Key Features

Composite display of CT, MR, NM and PET images – fast 

and easy for routine use.

Registration

• Quick first visual alignment with 6 degrees of free-

dom (3 x translation, 3 x rotation).

• Point-based high precision registration using ana-

tomical landmarks.

• Convenient landmark editor to improve precision.

• Storage of transformation matrix with data sets after 

registration for later retrieval.

Visualization

• Side-by-side MPR display of both data sets.

• Correlated pointer and correlated scrolling with dog-

ears for follow-up studies or tumor staging.

• 2D alpha-blending in monochrome or pseudo-color 

with adjustable balance between the two superim-

posed data sets to optimize representation of both 

data sets.

• Storage of fused results as secondary capture 

images.
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General Hints

• Surface Matching 
We recommend using Surface Matching only if you 

want to fuse objects that do not move, e.g. bone.

• Landmarks 
We recommend using Landmarks for therapy data 

sets, which are scanned with markers.

• Resample Data 
Is used to scroll simultaneously through the data sets 

and send them to other workstations.
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• Masking 
This function is used for a better display of either CT 

or PET images. With the sliders you can decide which 

data set should be displayed more.

• With the SmartSelect menu you can rotate the 

images fast and easy.

• It is possible to measure distances in the fused data 

sets.
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syngo Fly Through

syngo Fly Through is a Virtual CT Endoscopy Software 

integrated into the syngo 3D functionality. It offers the 

ability to render endoluminal views of structures such 

as the airways and vessels from volume data sets.

Virtual CT Endoscopy simulates diagnostic conven-

tional endoscopic procedures e.g. bronchoscopy and 

colonoscopy, that are usually uncomfortable and more 

invasive to the patient.

Key Features

• Add-on advanced 3D functionality (Fly icon) inte-

grated in the existing, familiar 3D taskcard.

• One-click access to perspective endoscopic render-

ing at a point of interest.

• Both Shaded Surface Display (SSD) and Volume Ren-

dering Technique (VRT) can be used.

• Volume Rendering Technique (VRT) presets can be 

stored in the VRT gallery and linked to specific 

examination protocol or series description.

• Endoscopic viewing parameters e.g. the viewing 

angle, depth and the viewing distance from the 

endoscope can be defined and linked to a data set.

• Manual or Automatic endoscopic navigation.

• Fly path planning creates and saves a flight path in 

the volume data set. This offers the ability to play 

back an endoscopic evaluation and to create a series 

of endoscopic snapshots that can be saved on the 

database.
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Prerequisites

This software works with CT, MR and conventional 

Angiographic data sets.

CTA data set with good vessel enhancement for virtual 

angioscopy.

Volume data set acquired with overlapping thin slice 

CT technique.

Use only axial images.
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Scanning Information

Patient Preparation

Bony and cartilaginous structures such as the central 

airway and bronchial tree, the osteomeatal system of 

the Paranasal Sinuses are inherently filled with air and 

therefore ideal for performing Virtual CT Endoscopy.

No special preparations are required.

For CT endoscopic evaluation of the vessel (virtual CT 

angioscopy), a good CTA data set with good vessel 

enhancement is required.

In the case of CT colonography, adequate preparation 

in bowel cleaning must be done prior to the CT exam. 

The bowel can be delineated with air, carbon dioxide, 

water or iodine/barium suspension.
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Workflow

Image Loading

Load the images in 3D.

The following standard layout is displayed:

Segment 1: Sagittal view

Segment 2: Coronal view

Segment 3: Transversal view

Segment 4: Fly segment with perspective SSD as de-

fault

Scroll through the MPR images until you reach an 

image where you would like to start the CT endoscopic

evaluation.

1 2

3 4
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Position the Reference lines at that point of interest e.g. 

in the trachea.

Click the Fly Through icon to activate the endoscopic 

display in the fourth segment.

The default endoscopic display has the same orienta-

tion (viewing direction) as the last selected image seg-

ment in which you placed the point of interest and 

invoked the syngo Fly Through option.

Change the endoscopic display by adjusting the SSD 

threshold or change to VRT display.

Link the new settings to data set for future evaluation. 

Define the Cone settings (endoscopic viewing param-

eters) and link the cone settings to data set for future 

application.

Start the endoscopic navigation by using:

• Manual method

• Auto-navigation

• Path creation

Create a flight path through the data set and save the 

path for future playback.

Click the Save Image button before navigating the 

endoscopic projection along the path.

A series of endoscopic snapshots will be created and 

saved automatically on the database.

These images can be documented on hardcopy or 

loaded to Viewer for cine display of the endoscopic 

movie.
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Navigation of the Endoscopic Volume

• Manual Navigation 
Click with the right mouse button in the Fly segment 

to activate the SmartSelect menu.

The following controls are available:

– auto-navigation

– push/pull

– rotate around viewing point

– rotate view

Adjust the viewing direction and select push/pull.

Click and hold the left mouse button.

Move the mouse up or down to navigate through the 

endoscopic volume manually.

• Auto Navigation 
Adjust the initial viewing direction. 
Activate the SmartSelect menu 
Select the function auto-navigation.

Click and hold with the left mouse button. Give the 

mouse a small upward push and then hold it steady.

The software will automatically detect the center line 

and navigate through the endoscopic volume without 

any user intervention.

To stop or change the direction of the navigation, 

release the mouse and adjust the viewing direction 

accordingly before proceeding further.
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Fly Path Planning

Open the Fly Path Planning.
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Create a path by inserting path points in the volume 

during navigation.

The relevant settings (viewing direction, viewing angle 

etc.) are stored along the path.

After defining and storing a path it is possible to play 

back the entire navigation along the path as a movie or 

to jump straight to the section of the endoscopic vol-

ume predefined by the path points.

Note: Only one path can be saved with each data set. 

To define another flight path through the same vol-

ume, the existing path will be overwritten and deleted.
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Additional Important 
Information

SSD and VRT Presets for Endoscopic 

Renderings

In order to create endoluminal displays with CT data 

sets, we need to differentiate the structures of interest 

from the rest of the anatomy. This can be achieved 

with either positive or negative contrast enhance-

ment.

In principle, there are few objects/media which are 

suitable for endoscopic renderings:

• Gas, e.g. air or carbon dioxide

• Fluid, e.g. water, Iodine-based intravenous/infusion 

media or Barium-based oral and rectal contrast 

agents

• Bone

• Metal, e.g. stents
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Endoscopic Viewing Parameters/Fly 

Cone Settings

In general, the shape of a pyramidal cone can be used 

to represent visualization of an endoscopic volume. 

The boundaries and the viewing perspective of the 

endoscopic volume are defined by adjusting the shape 

and size of this cone.

Cone setting for flying through the airways
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Cone Graphic and Definition

• Standing Point

– The cone rotates around the viewing point.

• Viewing Point

– The complete cone moves.

• Clipping Point

– The cone rotates around the standing point.

• Viewing Angle

– Is changed by moving one of the sides of the angle.

• Viewing Distance

– The distance from the Standing to the Viewing Point.

• Viewing Depth

– Moving the Front/Back Clip Plane changes the view-

ing depth.

• Front Clip Plane

– To remove foreground-obscuring tissue. The posi-

tion of the front clip plane will always be between 

standing and viewing point.

• Back Clip Plane

– To remove tissue at the back of the volume. The posi-

tion of the back clip plane will always be behind 

viewing point.

Viewing direction

Image

Plane

Back Clip Plane

Clipping Point

Viewing

Viewing

Standing Point

Viewing

Viewing Angle
Front Clip Plane

Viewing Plane

Depth

Distance

Point
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syngo Colonography

This is a promising application, dedicated to visualize 

and assist the physician with the evaluation of lesions 

in the colon. This study is not only non-invasive, but a 

much more comfortable method for the patient.

Key Features

• Very small lesions can be visualized

• Loading of two data sets for comparison

• After loading the images, the evaluation starts auto-

matically at the rectum position

• Lesion visualization in MPRs and virtual endoscopy

• Switching between single and side by side view

• Automatic endoscopic navigation

• Fly back offers a view from the opposite side

• Recording of a movie at any time

• Easy and flexible reporting of the evaluated lesions
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Prerequisites

A comprehensive study consists of four sections: Prep-

aration, examination in supine & prone positioning, 

and post-processing.

For your syngo Colonography evaluation, you can use 

one or two series of the same study or different studies 

of the same patient. The images must fulfill the follow-

ing conditions:

• Only load original, axial CT images of the same 

patient acquired without gantry tilt.

• Use only axial images.
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Scan Protocols

Use the CTColonography protocols. We recommend 

using a tube voltage of at least 120 kV.

You will find the CTColonography scan protocols 

under body region Abdomen.

Sensation 64

CTColonography

A typical range of 40 cm covered in 8.44 sec.

Colo_supine

kV 120

Effective mAs/

Quality ref. mAs

50

Rotation Time 0.5 sec.

Acquisition 64 x 0.6 mm

Slice collimation 0.6 mm

Slice width 1.0 mm

Feed/Rotation 26.9 mm

Pitch Factor 1.40

Increment 0.7 mm

Kernel B20f

CTDIVol 3.9 mGy

Effective dose Male: 2.40 mSv

Female: 3.71 mSv
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Colo_prone

kV 120

Effective mAs/

Quality ref. mAs

30

Rotation Time 0.5 sec.

Acquisition 64 x 0.6 mm

Slice collimation 0.6 mm

Slice width 1.0 mm

Feed/Rotation 26.9 mm

Pitch Factor 1.40

Increment 0.7 mm

Kernel B10f

CTDIVol 2.3 mGy

Effective dose Male: 1.44 mSv

Female: 2.23 mSv
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Sensation 40

CTColonography

A typical range of 40 cm covered in 12.90 sec.

Colo_supine

kV 120

Effective mAs/

Quality ref. mAs

50

Rotation Time 0.5 sec.

Acquisition 40 x 0.6 mm

Slice collimation 0.6 mm

Slice width 1.0 mm

Feed/Rotation 16.8 mm

Pitch Factor 1.40

Increment 0.7 mm

Kernel B20f

CTDIVol 4.2 mGy

Effective dose Male: 1.89 mSv

Female: 3.02 mSv

Colo_prone

kV 120

Effective mAs/

Quality ref. mAs

30

Rotation Time 0.5 sec.

Acquisition 40 x 0.6 mm

Slice collimation 0.6 mm

Slice width 1.0 mm

Feed/Rotation 16.8 mm

Pitch Factor 1.40

Increment 0.7 mm

Kernel B10f

CTDIVol 2.5 mGy

Effective dose Male: 1.14 mSv

Female: 1.81 mSv



syngo Colonography

63

 

Sensation Cardiac 64

CTColonography

A typical range of 40 cm covered in 8.44 sec.

Colo_supine

kV 120

Effective mAs/

Quality ref. mAs

50

Rotation Time 0.5 sec.

Acquisition 64 x 0.6 mm

Slice collimation 0.6 mm

Slice width 1.0 mm

Feed/Rotation 26.9 mm

Pitch Factor 1.40

Increment 0.7 mm

Kernel B20f

CTDIVol 3.9 mGy

Effective dose Male: 2.40 mSv

Female: 3.71 mSv

Colo_prone

kV 120

Effective mAs/

Quality ref. mAs

30

Rotation Time 0.5 sec.

Acquisition 64 x 0.6 mm

Slice collimation 0.6 mm

Slice width 1.0 mm

Feed/Rotation 26.9 mm

Pitch Factor 1.40

Increment 0.7 mm

Kernel B10f

CTDIVol 2.3 mGy

Effective dose Male: 1.44 mSv

Female: 2.23 mSv
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Sensation Open

CTColonography/CTColonography1s

A typical range of 40 cm covered in 5.96 sec.

Colo_supine

kV 120

Effective mAs/

Quality ref. mAs

50

Rotation Time 0.50/1.0 sec.

Acquisition 24 x 1.2 mm

Slice collimation 1.2 mm

Slice width 1.5 mm

Feed/Rotation 40.3 mm

Pitch Factor 1.40

Increment 1.0 mm

Kernel B20f/B20s

CTDIVol 4.5 mGy

Effective dose Male: 3.64 mSv

Female: 4.61 mSv

Colo_prone

kV 120

Effective mAs/

Quality ref. mAs

30

Rotation Time 0.50/1.0 sec.

Acquisition 24 x 1.2 mm

Slice collimation 1.2 mm

Slice width 1.5 mm

Feed/Rotation 40.3 mm

Pitch Factor 1.40

Increment 1.0 mm

Kernel B10f/B10s

CTDIVol 2.7 mGy

Effective dose Male: 2.18 mSv

Female: 2.76 mSv
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CTColonographyThin/CTColonography1sThin

A typical range of 40 cm covered in 12.90 sec.

Colo_supine

kV 120

Effective mAs/

Quality ref. mAs

50

Rotation Time 0.50/1.0 sec.

Acquisition 40 x 0.6 mm

Slice collimation 0.6 mm

Slice width 1.0 mm

Feed/Rotation 16.8 mm

Pitch Factor 1.40

Increment 1.0 mm

Kernel B20f/B20s

CTDIVol 5.5 mGy

Effective dose Male: 3.84 mSv

Female: 5.32 mSv

Colo_prone

kV 120

Effective mAs/

Quality ref. mAs

30

Rotation Time 0.5/1.0 sec.

Acquisition 40 x 0.6 mm

Slice collimation 0.6 mm

Slice width 1.0 mm

Feed/Rotation 16.8 mm

Pitch Factor 1.40

Increment 1.0 mm

Kernel B10f/B10s

CTDIVol 3.3 mGy

Effective dose Male: 2.30 mSv

Female: 3.19 mSv
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Emotion 6

CTColonography

A typical range of 40 cm covered in 31.23 sec.

Colo_supine

kV 130

Effective mAs/

Quality ref. mAs

50

Rotation Time 0.8 sec.

Acquisition 6 x 1.0 mm

Slice collimation 1.0 mm

Slice width 1.25 mm

Feed/Rotation 10.8 mm

Pitch Factor 1.80

Increment 0.8 mm

Kernel B41s

CTDIVol 6.60 mGy

Effective dose Male: 4.79 mSv

Female: 7.28 mSv

Colo_prone

kV 130

Effective mAs/

Quality ref. mAs

30

Rotation Time 0.8 sec.

Acquisition 6 x 1.0 mm

Slice collimation 1.0 mm

Slice width 1.25 mm

Feed/Rotation 10.8 mm

Pitch Factor 1.80

Increment 0.8 mm

Kernel B10s

CTDIVol 3.96 mGy

Effective dose Male: 2.88 mSv

Female: 4.37 mSv



syngo Colonography

67

 

CTColonography06s

A typical range of 40 cm covered in 27.87 sec.

Colo_supine

kV 130

Effective mAs/

Quality ref. mAs

50

Rotation Time 0.6 sec.

Acquisition 6 x 1.0 mm

Slice collimation 1.0 mm

Slice width 1.25 mm

Feed/Rotation 9.0 mm

Pitch Factor 1.50

Increment 0.8 mm

Kernel B41s

CTDIVol 6.60 mGy

Effective dose Male: 4.71 mSv

Female: 7.24 mSv

Colo_prone

kV 130

Effective mAs/

Quality ref. mAs

30

Rotation Time 0.6 sec.

Acquisition 6 x 1.0 mm

Slice collimation 1.0 mm

Slice width 1.25 mm

Feed/Rotation 9.0 mm

Pitch Factor 1.50

Increment 0.8 mm

Kernel B10s

CTDIVol 3.96 mGy

Effective dose Male: 2.82 mSv

Female: 4.34 mSv
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Emotion Duo

CTColonography

A typical range of 40 cm covered in 33.60 sec.

Colo_supine

kV 130

Effective mAs/

Quality ref. mAs

50

Rotation Time 0.8 sec.

Acquisition 2 x 2.5 mm

Slice collimation 2.5 mm

Slice width 3.0 mm

Feed/Rotation 10.0 mm

Pitch Factor 2.0

Increment 1.5 mm

Kernel B41s

CTDIVol 5.4 mGy

Effective dose Male: 3.54 mSv

Female: 5.63 mSv

Colo_prone

kV 130

Effective mAs/

Quality ref. mAs

30

Rotation Time 0.8 sec.

Acquisition 2 x 2.5 mm

Slice collimation 2.5 mm

Slice width 3.0 mm

Feed/Rotation 10.0 mm

Pitch Factor 2.0

Increment 1.5 mm

Kernel B10s

CTDIVol 3.2 mGy

Effective dose Male: 2.12 mSv

Female: 3.38 mSv
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Scanning Information

Patient preparation

Important for good results in a syngo Colonography 

evaluation adequate preparation in bowel cleansing 

must be done. The patient has to start with a diet and 

bowel cleansing two days prior to the examination like 

for a conventional Colonoscopy.

Patient examination

The bowel can be delineated with air, or, if desired, 

with carbon dioxide. Inflate the colon to the patient’s 

maximum tolerance. 
To decrease colon spasm, e.g. Buscopan™ or Gluca-

gon™ can be given IV. 
Usually, a prone and supine examination is done to dif-

ferentiate between polyps and stool within the colon. 

The second scan can be performed with lower dose, 

e.g. 30 to 50 mAs.
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Workflow

Layout of the Taskcard

After loading the series into syngo Colonography a  
4-segment layout is displayed.

• Upper left segment: 
Scroll View using MPR for fast and easy navigation 

through the colon. As default, a coronal view is dis-

played. Markers can be set for further evaluation and 

documentation.

• Upper right segment: 
Scroll View using MPR for fast and easy navigation 

through the colon. As default, a transversal view is 

displayed. Markers can be set for further evaluation 

and documentation.

• Lower left segment: 
Global View showing a three-dimensional unob-

scured, overall view of the whole colon in a double-

contrast display. This segment provides an overview 

with markers, the current position of the virtual 

endoscope and its field of view, and the path trav-

eled in the Endo View Segment.

• Lower right segment: 
Endo View looks like an original endoscopic view, 

using perspective SSD (pSSD). With the auto naviga-

tion a flight with the virtual endoscope along an 

automatically calculated path is started.
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User interface of syngo Colonography

Supine and prone position in “Side by Side” view.
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Visualization and Evaluation

Two alternative workflows are possible:

a)First identify and mark all the suspected lesions in 

the entire data set during the first pass navigation. 

As a second step you can do the individual close-

up evaluation of the pre-marked lesions.

b)Immediately evaluate each suspicious lesion as 

soon as it is visualized during the first navigation.

Identification and Marking of Lesions

• Load one or two series of the same patient into 

syngo Colonography. The images are always dis-

played in the same orientation The system will auto-

matically find the starting point at the lowest posi-

tion in the rectum.

• Select the desired data set (A or B) or use the side by 

side view for comparison.

• Scroll through the data set with the slabs of the two 

Scroll Views.

• Set the virtual endoscope to the required start point.

• Fly with the virtual endoscope forward and back-

ward through the volume to identify lesions. The 

Global view provides an overview of the current posi-

tion and the path traveled.

• Set lesion markers in the Endo View or in the Scroll 

View segments. The markers always get the exten-

sion of the corresponding data set, e.g. 1a.

• You can change the viewing angle in the endoscopic 

view via the “zoom/pan” button.

• Set a bookmark temporarily, to save all segments 

with all parameters, i.e., position, zoom/pan, orien-

tation.
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Close-up Inspection of Lesions

• Turn the virtual endoscope to look exactly at the 

lesion of interest.

• Activate Fly Around and rotate the volume displayed 

around the centered marker to view the lesion from 

all sides.

• Fly backward to get a view of the lesion from the 

opposite direction.

• Change to Side by Side View to differentiate 

between polyps and fecal matter.

• Switch between endo and combined mode to dis-

play the surrounding tissue.

Measurements of Lesions

• Select a marker from the marker list, all segments 

will be updated to the position of the marker.

• Select a Scroll View segment where the lesion is best 

visible.
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• Activate Blow-up mode.

• Click on the Distance button on the Evaluation sub-

task card and draw a distance line.

• With the Goto image button you can easily jump to 

the image with the corresponding distance measure-

ment.

Documentation and Reporting

• In the Endo View Segment, you can record a movie 

of your virtual flight through the colon at any time.

• As soon as distance lines are measured, they are doc-

umented in the Colonography Lesion Details dia-

log. You can add comments to each entry.

• You can include up to four images for each lesion in 

your report. Select the image you require and copy it 

to the report. The copied image is also saved in the 

local database.

• During the evaluation, specific details such as the 

location, quality, and size of each lesion can be 

entered into the Colonography Lesion Details dia-

log.
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The Report Wizard provides a brief table of the evalu-

ated lesions.

You can enter any additional observed abnormalities 

and the conclusion as well.

• The Report template is configurable.

• It is possible to print the report or to export the 

report in several formats, e.g. PDF-, HTML- or RTF-

Format.

Ending an Evaluation

– After ending the Colonography Evaluation the Save 

report dialog appears. For identification of the cre-

ated report you can enter a comment.
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InSpace4D

syngo InSpace4D is an interactive volume viewer tai-

lored for modern volume scanners.

syngo InSpace4D is the real-time volume rendering 

application of syngo offering excellent image quality 

and interactive performance even with your largest 

data sets. The primary focus of syngo InSpace4D is to 

melt very rapidly through a complete 3D image vol-

ume using a clip plane or image slab to reveal the 

desired anatomy. This is analogous to 2D-cine mode, 

but much faster, and with freely controllable double-

oblique orientation within the entire 3D volume.
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Key Features

• Genuine real-time 3D

• VRT, MIP, MinIP, MPR

• Clip plane and image slab melt-through

• Excellent image quality

• Support for very large volumes

• 3D measurements

• Documentation, including AVI digital movies 

You can use the optional VolumePro Graphics accel-

erator card to provide exceptional image quality and 

provide support for very large volumes at maximum 

interactive performance. The InSpace/Settings/Qual-

ity menu allows you to activate and deactivate Vol-

umePro mode.
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Prerequisites

Loading of Images

• Only load CT, MR and AX images.

• We recommend not to load more than two data sets 

at the same time.

• A cardiac study containing multiple series can be 

loaded for 4D viewing.

• You should close any data set that you no longer 

need in order to release memory space and maintain 

application performance.

• CT volume data sets are best acquired with overlap-

ping thin slice CT technique.

If the data you have selected contain several volumes 

for display, the Volume Selector dialog box opens.

You have the option to:

• Select a single data set, 

• Merge two or more data sets to form a volume, or

• Display two or more data sets as separate volumes.
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• Select exactly two volumes from the same patient 

with the same parameters to merge them to one vol-

ume.

• Select multiple time-sequence volumes from the list 

to view them in motion.
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Layout of the Screen

The image area is used for 3D VRT, MIP, MinIP or MPR  

image display in one, two or four segments. Whenever 

you change image parameters, the modifications are 

displayed in real time.
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The taskcard control area consists of:

• Mode buttons 
The six mouse mode buttons on the left are used for 

image control. The two buttons on the right are used 

for High Quality and Hide All Graphics.

• Upper stack of subtask cards 
These subtask cards are used to set rendering mode, 

screen layout and the Advanced Lighting function. 

This button is only available with the optional Vol-

umePro graphics accelerator. Also two subtask cards 

used for orientation and tissue classification.

• Button Load Modality Preset and Sliders for Bright-

ness and Opacity. These sliders set the overall opac-

ity/ brightness of the image. If multiple ramps and/or 

trapezoids are present, all will be adjusted together.

• Lower stack of subtask cards. 
Contains the settings for clip planes, tools and mea-

surements.

• Input/output buttons 
These buttons are used to save or film result images, 

and to close the current series.

• Image segment area layouts 
Four different layouts of the image area are pro-

vided:

– Single View Mode

– Two View Mode

– Four View Mode

– MPR View Mode
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The layout can be modified:

– Blow-up any segment to full-screen by double-click-

ing. 
To bring display back to original layout, double click 

left mouse again.

– Drag segment boundaries or intersection in 2- or 4-

view layouts.

– Reset layout by clicking again on the depressed lay-

out icon.
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Startup Configuration

A default startup layout can be configured, or the star-

tup layout can be linked to a series description so that 

the layout is applied automatically for all such series:

• To make a Default startup bookmark for the selected 

series create the screen layout and image settings 

that you need, then select main menu InSpace > 

Save Series Bookmark as...:

– check the Bookmark box

– press Make Default

– press Save&Close



86

 

syngo InSpace4D

• To make a startup bookmark that is linked with a spe-

cific Series Description, load a relevant series, cre-

ate the screen layout and image settings that you 

need, then in InSpace > Save Modality Preset:

– check the Bookmark box,

– select Linking – Link Current 
Linking – Preset Link displays all available links 

for the specific series.

– press OK.

• To make this be the default:

Select Make Default, it is used when no series descrip-

tion link matches the series description of the volume 

being loaded. 
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• To activate the auto layout mechanism select Yes or 

Ask me in InSpace/Settings/Bookmarks – Auto 

Configuration Loading.



88

 

syngo InSpace4D

Workflow

In general, syngo InSpace display, evaluation and doc-

umentation tools can be used in any workflow 

sequence. For an interactive 3D diagnosis using dou-

ble-oblique "3D melt-through" a typical workflow 

would involve the following steps:

• Load series into a (default) MPR layout (MPR View 

Mode)

• To view axial data set, scroll through the axial MPR 

segment using left mouse button push-pull (double-

click segment if you want it full screen).  
Tip: press the Quality button to ensure maximum 
image quality.

• Select 1 x 1 layout to show the 3D View. 
Tip: release Quality button for maximum interactive 

performance.

• To evaluate soft tissue, select VRT rendering mode, 

or a soft tissue preset, and add a single clip-plane. 

Adjust window settings using middle mouse button, 

and also the opacity if necessary. Adjust clip-plane 

position and orientation to melt through and reveal 

desired anatomy.
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• To evaluate vessels, select a MIP preset and add a pair 

of clip planes using Slab Mode, or simply select slab-

MIP rendering. Adjust window settings as needed 

using middle mouse button. Adjust slab position, 

thickness and orientation to see only the required 

vessels.

• Manipulate the volume by pan, zoom and rotation 

using mouse mode icons at top of task-card.

• At any time during the interaction you may use tools 

to make annotated measurements, edit the data, 

and document to film sheet, disk-file image such as 

JPEG or AVI digital movie in MPEG4 format.

Rapid diagnosis is supported by series-linked book-

marks that anatomically select optimal parameter set-

tings, rendering mode, and even the screen layout for 

each exam protocol and by comprehensive tool-set of 

measurement and editing functions. In addition to 

conventional image reporting in DICOM format, jpeg, 

tiff images and MPEG4 movies of real-time interaction 

can be easily created.

• Use modality presets to select different rendering 

settings, including color VRT.

• Ramp and trapezoid manipulation: Ramps and trap-

ezoids are functions which define window and ren-

dering settings. Trapezoids can also be used to differ-

entiate a tissue classification range (e.g. soft tissue 

versus bone in a CT image).
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• Change rendering settings using the table classifier 

trapezoids. Moving the ramp changes the window 

width and center. Opacity and brightness can be 

adjusted to optimize organ-specific settings. With 

the right mouse button, options related to ramps 

and trapezoids are available.

• Lighting to enhance 3D. The lighting direction arrow 

is used to define the direction of incident light.

• In addition to the individual mouse mode icons, all 

volume and clip-plane manipulation can be accom-

plished without mode change using the Manipulate 

all objects icon.

• In this mode, Pan and Zoom can be performed even 

when a clip-plane is present by using the middle 

mouse button while pressing the Shift key.
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MPR Mode

• Double oblique MPR 
The MPR View Mode divides the image area into 

three orthogonal reference images with the 3D view 

in the fourth segment. Adjust the reference line cen-

ter position and orientation to create double-oblique 

views.

Hint

The Reference lines are hidden after some seconds. If 

you move the cursor in one of the MPR segments the 

refernce lines are available again.
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Editing the Volume

• Cropping (Tools - Volume Cropping) 
This editing method is used to crop the entire vol-

ume (box edit). Cropping limits you to three orthog-

onal directions.

• VOI punching 
ROIs can be used to remove more complex shapes 

from the volume. ROIs can be drawn around the 

wanted (keep inside) or around the unwanted (keep 

outside) region. Drawing several ROIs before punch-

ing saves time.

• Clip planes 
Clip planes can also be used for hiding parts of the 

data set. The number of clip planes available 

depends on the selected mode:

– with VolumePro: four

– without VolumePro: six

Hint

The ROI punch can be applied to the whole volume, or 

to only the parts visible when using clips or slabs. This 

is useful for editing bone in complex regions.

Measurement and Evaluation

• We recommend performing measurements on MPR 

planes. For 2D measurements, always use clip planes 

oriented parallel to the screen.

• Select on the "Orientation Card", "Align view so cur-

rent clip plane is parallel to screen".
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• Measure by placing a grid over the image, and mov-

ing its center and orientation as required.

• Measure distances and angles using the measure-

ment feature on the Tools subtask card.

Documentation to Film and Database

• Images can be documented to the virtual film sheet, 

or a Postscript printer.

• Images can be saved to the DICOM patient database, 

or can be exported to disk file in JPEG, BMP, TIF, PNG 

formats.

• Digital movies 
You can generate digital movies, using various com-

pressed AVI formats, such as MPEG 4. You can then 

replay movies on other computers or send them 

from there via the Internet or Intranet, to discuss 

findings with other specialists, for example.

• Output ranges 
The Ranges function provides a simple way of creat-

ing a radial or a parallel range series from 3D images. 

You can then send these series to the screen, output 

them on film or as a movie, or store them to the 

patient database.

Hint

Select a 3D view to define start and end points for 

radial ranges and a MPR view to define parallel ranges.
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Bone Removal

With Bone Removal you can create an edited version 

of a volume, and mask out certain structures for diag-

nosis. For a clear view on vessels filled with contrast 

medium, you will mask out bones, to view a fracture 

you will display only bones. 

When performing Bone Removal to extract or to mask 

out structures, you have to follow the workflow given 

on the Bone Removal dialog box. First you select the 

corresponding body region to set the default global 

segmentation parameters. You can then correct the 

automatic segmentation results manually and save the 

segmentation results. You can modify the default glo-

bal segmentation parameters, if necessary, and store 

these settings as new default value.

Segmentation

After calling up Bone Removal, you first select the 

body region of interest (Body, Head or for fracture 

analysis Fracture). By doing this you are setting the 

global segmentation parameters with respect to the 

special segmentation conditions of the different body 

regions. Additionally you can change the threshold HU 

manually. Note, that modifying the predefined HU 

value may lead to unwanted segmentation results that 

cannot be corrected. In this case, you have to restart 

segmentation. 
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By selecting the body region Head or Body you are 

masking out the bones. 

By selecting Fracture you display only the bones. This 

selection can be corrected subsequently. 

Structures that have been misinterpreted during seg-

mentation and are displayed as bones, misleadingly 

can be defined as non-bone structure and vice-versa.
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Parameter Settings

After segmentation you can modify the segmentation 

results by correcting the segmentation parameters.

Segmentation Strength

By selecting a suitable value between 0,0 and 100 for 

the parameter Segmentation Strength you can 

enhance the accuracy of the segmentation. If the 

value for the Segmentation Strength is 0,0 nearly all 

bones are unmarked. With a value of 100,0 nearly all 

structures are marked as bones. 

Noise Tolerance

To prevent the fusion of different structures, change 

the value of the Noise-Tolerance. The higher the noise 

in the image, the higher the HU-value should be.

Display Mode

Applying the saved bookmark on the original data set 

you can restore the segmentation results.
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After all relevant bone structures are marked and dis-

played correctly, you can select following display 

modes for diagnosis: 

• Bones – only structures you marked as bones are 

displayed 

• Highlight – the marked structures are displayed

• Non-bone – only structures you marked as non-

bone are displayed

• Both – all structures are displayed.  

After refining the segmentation results you can cancel 

every segmentation correction by undoing the last cor-

rection or all corrections. 

You can save the bone segmentation results as book-

mark. Applying the saved bookmark on the original 

data set you can restore the segmentation results.

After step 3 "finish", the segmentation results can be 

corrected at any time by selecting step 2 card "refine" 

again. 
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Additional Important 
Information

• InSpace bookmarks are stored in a separate series, 

called "InSpace bookmarks". 

• The series "InSpace bookmarks" can be sent and 

stored to any storage device.
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4D Viewer

In addition to its unique performance in displaying 

huge static CT volume data sets, the new syngo 

InSpace4D offers true 4-dimensional evaluation of the 

heart, based on data reconstructed in up to 24-phases 

of the cardiac cycle.

Combined with the VolumePro graphics accelerator 

card, the new software enables real-time visualization 

and diagnosis of the beating heart, evaluation of func-

tional defects, and navigation in any arbitrary plane.

4D reading is achieved using either clip planes or slabs 

that can be positioned interactively in order to show, in 

real-time, the desired anatomy.
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Select multiple time-sequence volumes from the local 

database (axial multiphase series). For further infor-

mation about the reconstruction, please refer to the 

chapter "Multiphase Reconstruction on the Examina-

tion or Recon card" in the Heartview Application Guide. 

Load these series into syngo InSpace4D and select 

Use 4D from the Volume Selector.
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Case Examples

Soft Tissue Evaluation using Clipped 

VRT

1.Load series.

2.Select soft tissue preset, adjust windowing as 

needed.

3.Enable a single clip-plane.

4.Manipulate volume to evaluate anatomy:

a)Orientate the clip-plane and image volume for the 

best view of the anatomy.

b)Push-pull the clip plane through the volume.

c) Adjust window and opacity as necessary.

d)Pan and zoom image as necessary.

e)To eliminate unwanted bone you can use Bone 

Removal, activate clip planes or use VOI punching.

5.Measure, annotate and document as needed.
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Examination of Vascular Trees, using 

Slab MIP

1.Load series.

2.Select slab-MIP rendering.

3.Select MIP preset, or adjust window.

4.Manipulate volume to evaluate anatomy:

a)Orientate the slab and image volume for the best 

view of the anatomy.

b)Push-pull the slab through the volume.

c)Adjust window and opacity as necessary.

d)Pan and zoom image as necessary.

e)To eliminate unwanted bone you can use Bone 

Removal, activate clip planes or use VOI punching.

5.Measure, annotate and document as needed.

6.Optionally, create image series using radial ranges 

and output them either on film, local database, or as 

digital movie.



104

 

syngo InSpace4D

 Vessel Analysis Using Color VRT

1.Load series.

2.Select color VRT preset.

3.Manipulate volume to evaluate anatomy:

a)Orientate the image volume for the best view of 

the anatomy.

b)Use clip planes to hide unwanted anatomy.

c) Adjust window, opacity, color and lighting effects 

as necessary.

d)Pan and zoom image as necessary.

e)To eliminate unwanted bone you can use Bone 

Removal, activate clip planes or use VOI punching.

4.Use lighting for optimum 3D display 
(in VolumePro mode only).

5.Either select a default preset that has lighting or 

define your own lighting effects and set the incident 

light direction (usually from the front). 
Lighting options and recommendations:

a)Shading: 80

b)Surface Enhancement: 20

c) Diffuse: 70

d)Highlights: 80

e)Shininess: 20 
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6.Measure, annotate and document as needed.

7.Optionally, create image series using radial ranges 

and output them either as a film, database, or digital 

movie.

You can also perform oblique MPR assessment of ves-

sels as follows:

1.Align a single clip plane so that it cuts the vessel in 

the same direction as the required MPR.

2.Select Align MPR view from the Orientation sub-

task card.

3.If necessary, also adjust MPR positions and perform 

measurements.
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Examination of the Colon

1.Load series.

2.Select the caudo-cranial view.

3.Select double-contrast colon VRT preset.

4.The table parameters are based on a single trapezoid 

with the following properties:

a)Very narrow trapezoid.

b)Trapezoid positioned on the Hounsfield scale in 

the region of air.

c) Reduced opacity (opacity approx. 25).

5.Manipulate volume to evaluate anatomy:

a)Orientate the image volume for the best view of 

the anatomy.

b)Adjust window and opacity as necessary.

c) Pan and zoom image as necessary.

d)Use a clip plane to hide parts of the colon if neces-

sary.

6.Measure, annotate and document as needed.
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syngo Vessel View is a dedicated tool for 3D visualiza-

tion and analysis of vascular structures in MR and CT 

data sets.

In addition to vessel analysis, this option is also useful 

for pre-surgical evaluation, which requires direct mea-

surements in a 3D-volume data set.

Key Features

• 3D visualization with MPRs, MIPs, and Volume Ren-

dering.

• VRT presets shared with the common gallery avail-

able with the syngo VRT option on the 3D card.

• 3D editing with clip planes or VOI punching.

• Semi-automatic segmentation of complete vessel 

trees & intuitive path planning.

• Manual path planning along the vessel & manual 

vessel segmentation with the Tube Mode.

• Vessel Navigator which creates a Ribbon MPR as an 

overview image.

• Display up to 3 flags at the normal and minimum 

diameters or cross-sectional areas of the vessel.

• Automatic calculation of the stenotic ratio in per-

cent.

• Straight & curved distance measurements directly in 

the Vessel Navigator or in the VRT segment.
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• Angle measurements directly in the volume seg-

ment.

• Automatic contour detection and area calculation of 

the vessel lumen orthogonal to the center line path.

• The quantification results are summarized in output 

tables (Reports) that can be documented as hard-

copy or stored together with the corresponding 

images in the database.

• Setting of annotation texts either along the path in 

the VRT segment or anywhere in the 3D volume in 

the MPR segments to identify anatomically impor-

tant coordinates.

Prerequisites

Volume data set with good opacification for vascular 

analysis, with overlapping thin slice and a soft kernel 

reconstruction are recommended.

To ensure optimal enhancement after the contrast 

medium injection a Test bolus or Bolus Tracking using 

CARE Bolus (optional) should be used. For the coro-

nary vessels and the large thoracic vessels, best results 

can be achieved with ECG-synchronized scanning 

using the HeartView CT.

Use only axial images.
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Workflow

Loading the Images

After loading the images into syngo Vessel View the 

following layout is displayed:

MPR Segments

The three small segments on the left are referred to as 

MPR Segments although these segments may also dis-

play MIP Thin and MPR Thick. These segments contain 

reference lines, as in the 3D card, which allow you to 

rotate and translate image planes. 2D measurements 

are also possible on these segments.

Menu Bar

MPR

Segment

Sagittal View

MPR

Segment

Axial View

Control

Area

MPR

Segment

Coronal View

Volume

Segment

Measurements or

 Vessel Navigator

Status Bar
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Volume Segment

This segment displays the complete volume data set 

either in VRT or MIP representation.

Hint: VRT presets are shared with the common gallery 

available with the VRT option on the 3D card. Since 

Vessel View applies a different volume rendering 

algorithm that provides no “shaded” display like the 3D 

card, it may be helpful to create and save your specific 

Vessel View VRT settings.

A green arrow, the so-called Focus Pointer indicates 

the current position in the volume, e.g. for creation of 

annotation texts. The Focus Pointer also indicates the 

intersection point of the three MPR segments.

The orientation cube in the lower right corner may be 

used to quickly change the orientation of the volume 

data set. A single click on one side of the cube will set 

the orientation of the volume to that side. A double-

click anywhere on the cube will set the orientation and 

the zoom factor of the volume back to their default val-

ues.
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Vessel Navigator

The Vessel Navigator shows a longitudinal cut along 

the center line of the vessel. An area curve of the ves-

sel’s cross-sectional area is displayed as a graphical 

overlay on the Vessel Navigator image.

You can move along the vessel and rotate the Vessel 

Navigator image about the vessel axis. The Focus 

Pointer (known from the Volume Segment) is repre-

sented by a green vertical line.

When moving the Focus Pointer, the three MPR Seg-

ments are synchronized to the position of the Focus 

Pointer.

Visualization

This step is used to get an initial impression of the data 

set and, if necessary, remove structures which hide the 

view on the structures of interest.

To get an initial impression of the data set, you may 

view it in VRT or MIP representation in the Volume Seg-

ment or page through the data set in the MPR Seg-

ments.
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Working with the VRT/MIP representation in the Vol-

ume Segment you may typically

• Apply a VRT preset from the VRT Gallery.

• Create your own VRT preset.

• Change the W/C setting with the middle mouse but-

ton.

• Freely rotate the volume.

• Click on the Orientation Cube to quickly set the ori-

entation to desired standard views.

• Blow up the Volume Segment to full screen size.

Working with the MPR Segments you may typically

• Page through the axial, sagittal and coronal views.

• Change the views to any oblique/double-oblique 

view.

• Change the W/C setting with the middle mouse but-

ton.

• Blow up one MPR Segment to go to the Volume Seg-

ment.
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Working with the Vessel Navigator you may typically

• Change W/C setting with the middle-mouse button.

• Change the Ribbon Viewer width (if less than the 

full vessel width or not enough surroundings are 

shown).

• Zoom/Pan to display the region of interest.

• Display curves of either the cross-sectional area of 

the vessel or a combination of the minimum, maxi-

mum and equivalent diameters along the vessel’s 

center line.

• Measure straight distances perpendicular to the ves-

sel (e.g. diameter of the vessel).

• Measure curved distances along the vessel’s center 

line.

• Rotate the Ribbon MPR step by step or in cine mode.

• Change the display to MIP Thin.

To remove unwanted structures you may

• Punch out unwanted structures.

• Apply clip planes.
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Segmentation

In this step, you place certain seed points in order to 

identify the vessel of interest and define paths along its 

center line. These paths can be the result of a semi-

automatic or fully manual segmentation procedure. 

– Select Configure > Show Magnifier Window from 

the main menu to set the seed points easier, mainly 

on small vessels.
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You can drag & drop the Magnifier window to any posi-

tion on the screen.

a) Semi-Auto Segmentation

With the Semi-Auto Segmentation all path points are 

automatically set by the application.

Segmentation steps:

Step 1: Select the vessel type that you want to segment 

(aorta, carotids, coronaries or other). 
The segmentation algorithm is adapted to the vessel 

type you selected.



syngo Vessel View

117

 

Step 2: Set one or more seed points.

There are two different types of seed points:

Center points – e.g. one click for the complete aorta

End points – e.g. prevents the segmentation to run 

from carotids into aortic arch.

You can set points in all segments.

You may set any number of center points and/or end 

points. For the segmentation of coronaries, two end 

points have to be set.

Step 3: Adjust sensitivity (threshold for segmentation).

Set the required threshold value with the slider.

Voxels of an intensity below the segmentation thresh-

old are excluded from the image segment. Check the 

view and correct the setting if necessary. 

Step 4: Define paths along the branches of the vessel 

tree by performing two clicks into the VRT 

image for each path. You may define as many 

paths as necessary.

As soon as you have created all paths click Done.

Paths are displayed in the image segments as a colored 

line through the middle of the vessel.
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You only have to:

– Position one or more seed points anywhere in the 

vessel of interest via the left mouse button.

– Position individual seed points in the most suitable 

image segment (Volume or MPR segment).

– Position an end point where vessel branches run into 

other vessels, if necessary.

– In many cases, e.g. the aorta, only one seed point is 

necessary to trace the whole vascular tree.

– Adjust the threshold to remove bone or any other 

unwanted structures. The segmentation algorithm 

automatically finds the vessel limits and determines 

the whole vessel tree.

– As a last step, plan as many paths as wanted in the 

Volume segment.

Hint 

For an optimal performance of the segmentation algo-

rithm:

Limit the size and especially the complexity of the vas-

culature that you would like to segment.

To achieve this:

– Place at least two end points during the segmenta-

tion workflow. One end point proximal and one dis-

tal to the vasculature of interest.

– After the segmentation modify the HU threshold by 

moving the slider that only the vessels of interest are 

visible and all bones are excluded.

For some cases where the vessels are completely 

occluded, it may be not possible to define a path along 

these vessels after segmentation. As a workaround 

you can use the Manual Path Creation.
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b) Manual mode

With the manual mode all path points have to be set by 

you.

– Position path points at the beginning of a vessel and 

wherever the vessel changes its course and at the 

end of the vessel.

– Position the individual path points in the most suit-

able image segment. (Volume or MPR segment).

– For the identification of branched vessels, position a 

path point where the branches join.

Depending on the number as well as accuracy used in 

positioning the path points, the paths represents the 

actual course of the blood vessel.

Manual mode does not isolate the vessel tree from the 

surrounding tissue and bones. For this purpose Tube 

Mode may be used.
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Path Modification

After segmentation has been completed, each path is 

given a unique name. You may modify the path name, 

e.g. to an anatomical name and add an explanatory 

note to each path.

To improve the visibility of paths, the translucent mode 

is automatically switched on after segmentation.

You can modify the course of a path in the Volume or 

the MPR Segment by using the Edit entry in the con-

text sensitive menu (right mouse button).
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Measurement Analysis

Flags

Flags are special area measurements. There are usually 

two or three flags associated with each path, but they 

can also be turned off completely. You can move them 

in the Vessel Navigator to healthy (one or two flags, 

called Normal A and Normal B) and stenotic (the flag 

called Minimum) parts of the vessel.

When their contours (on the Vessel Orthogonal MPR) 

are accepted their values are displayed in the Mea-

surement List. Accepted area measurements and flags 

are shown as (planar) contours in the Volume Seg-

ment.

They have the same color as their MPR counterpart.

Stenosis Ratio Values

Each path has a variable number of Stenotic Ratio val-

ues displaying the ratio of the Minimum flag to the 

average of the Normal A flag and the Normal B flag (if 

available).

The parts that are used for this ratio are: area, mini-

mum diameter, maximum diameter and/or equivalent 

diameter, and this is determined globally in the config-

uration dialog.
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The value that is displayed is actually 100% minus the 

ratio (following the NASCET criteria), resulting in a per-

fectly healthy vessel being assigned a 0% stenosis and 

a totally obstructed vessel being assigned a 100% 

stenosis.

These values only appear in the list after the flags’ con-

tours are accepted (= validated). The names are auto-

matically created, incrementing a number at the end. 

The name can then be changed by you.

Navigation along a path

After creating a path the MPR Segments are automati-

cally set to the Vessel Orthogonal Orientation.

This means that the previously standard axial view will 

now be a view orthogonal to the center line of the ves-

sel; the previous standard coronal and sagittal views 

are now views tangential to the center line of the ves-

sel.

You have the ability to switch back to the Patient 

Orthogonal Orientation. This means that the MPR 

Segments remain in the true orthogonal orientations 

(axial, sagittal, coronal view) as you scroll along the 

path.
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You can set the MPR Segments individually to display 

the current view in MPR, MIP, MPR Thick or MIP Thin 

representation.

Using the Focus Pointer you can move along the path 

and follow the Vessel Orthogonal MPR Segments.

Tube

Tube is a clipping tool, which creates a cylindrical vol-

ume following the center line of the selected vessel. 

The radius of the tube can be selected by you. Tube 

provides a quick way to either keep the tube volume (= 

the volume around the vessel) and remove the sur-

rounding structures, or to remove the tube volume and 

keep the surrounding structures.

Usually this only makes sense after a manual path cre-

ation, because the segmentation does a more precise 

job in separating vessel from surrounding tissue.
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Fader

Removed parts of the volume are not really deleted 

from the data set. Instead, they are hidden by the 

Fader. With the Fader, you may modify the transpar-

ency of the removed volume.
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Axial Cuts

This button is only enabled (ungrayed) when a path is 

selected.

– The FoV of the axial MPR image represents the FoV 

of the resulting Axial Cuts range: Zoom/pan the path 

orthogonal MPR image to the best view, then select 

button Axial Cuts in the control area.

– You can specify the begin and end of the range (in 

mm).

– You can enter a distance between the cuts. The sys-

tem calculates the resulting number of slices 

(images).

– While this dialog is open, the VRT shows the location 

of the cuts as squares.

– Pressing Cancel hides the dialog and the squares in 

the VRT segment.

– Pressing Start saves the images to the database.
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Performing measurements

You can

– Measure straight distances in MPR and VRT views 

and on the Vessel Navigator (VN)

– Measure curved distances in VRT view and on the VN 

– Perform automatic measurements of the vessel’s 

cross-sectional area. After semi-automatic segmen-

tation, a colored vessel contour is displayed on the 

vessel-orthogonal MPR view. You can accept this 

contour as official contour.

– Draw and evaluate free-hand ROIs

– Modify existing contours

– Measure angles

You can hide measurements and show them again 

with the menu options Configuration > Show All 

Measurements.
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Documentation of Results

The buttons Save to Database and Copy to Filmsheet 

are always available. You can always document inter-

mediate results using these two buttons.

Hint: Save to Database and Copy to Film Sheet are 

always applied to the currently selected segment. 

Make sure that the correct segment is selected.

Save Session and Load Session

Use the menu option File/Save Session to save inter-

mediate results of a Vessel View session. Restore the 

session by first loading the patient images to Vessel 

View and then selecting File > Load Session.

Do not delete the series VVIEW_NONIMAGE_SERIES 

until you have fully completed the evaluation of your 

patient. This series contains non-image data which is 

required by the Load Session function to restore a pre-

viously interrupted session.
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Create report

The Report button creates several output tables of the 

measurement results. These tables are automatically 

stored to the database and can be sent to the film 

sheet.

Graphical documentation of measurements

The Measurement list displays all measurements cre-

ated in this session. Selecting an entry of this list will 

display the VRT and MPR images associated with this 

measurement. You can then apply the buttons Save to 

Database and Copy to Filmsheet to the relevant seg-

ments.

AVI-File of Volume Segment and Vessel Navigator 

image

You can generate an avi-file of the Volume Segment or 

the Vessel Navigator image rotating around the vessel 

axis depending on which segment is currently 

selected.

For movie creation Vessel View uses the MPEG-4 

Codec V1. This codec must be installed on the PC on 

which the movie is to be replayed.
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Case Examples

Workflow for an Aortic Aneurysm Case

Visualization

Use VRT settings and window settings for good visual-

ization of the aortic and iliac arteries.

Adjust the VRT view by using presets from the VRT Gal-

lery. You can fine-tune the settings by adjusting the 

trapezoids in the Definition card.

If necessary, remove unwanted volume structures by 

using the Clip Plane or the VOI Punch function.

Semi-Automatic Segmentation

Activate the semi-automatic segmentation mode.

Place center seed points into the aorta. In many cases, 

one seed point is sufficient. Place the seed points 

either in the MPR segments or in the VRT segment.

As soon as you press the Next button, an automatic 

segmentation will be performed and keep mainly the 

aortic lumen. After segmentation, the translucent 

mode is automatically switched on.

Define paths along the aorta or other vessel branches 

by two clicks for each path.
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Editing & Merging Paths

Following segmentation of the aorta, the resultant 

paths are shown as a list on the Measurement card.

You can edit the paths by repositioning the path points 

along the path into the center of the vessel lumen.

You can also merge paths by selecting two paths from 

the Measurement card at a time and clicking the 

Merge button.

Measurements

Select the path of interest on the Measurement card.

Move the Focus Pointer, e.g. by dragging the green 

vertical line in the Vessel Navigator.

The 3 MPR segments are now displayed orthogonal to 

the path. These images will be updated as you change 

the position of the Focus Pointer.

The following measurements can be performed:

1.Curved Distance directly in the Vessel Navigator 

e.g. origins of the renal arteries to neck of the aneu-

rysm.

2.Curved Distance in the central long axis of the aneu-

rysm between the upper and lower necks of the 

aneurysm.

3.Straight Distance for maximum diameter of the 

aneurysm or any of the aortic branches, i.e. the iliac 

arteries.

4.Automatic contouring and area calculation of the 

lumen of the aneurysm or the aortic branches, i.e. 

the iliac arteries.

5.Angle Measurement
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Hint

For the evaluation of very large findings, e.g. aortic 

dissections, where the accuracy of 3D measurements 

is sufficient, we recommend to reformat MIPs/MPRs in 

syngo 3D.
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Workflow for a Coronary Case,  
e.g. LM and LAD

In the area of the coronary vessels and the large tho-

racic vessels, best results can be achieved with ECG-

synchronized images using the HeartView CT soft-

ware. Motion artifacts which typically occur in the cor-

onary vessels and in the large thoracic vessels can thus 

be avoided. 

Prerequisite for the evaluation is an optimum enhance-

ment in the vessels of interest. We recommend using 

Bolus Tracking.
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We recommend using a heart phase where the vessels 

of interest are best displayed. Also a smooth kernel is 

recommended.

Visualization

Use VRT settings and window settings for good visual-

ization of the Left Main (LM) and the Left Anterior 

Descending Artery (LAD).

Adjust the VRT view by using presets from the VRT Gal-

lery. You can fine-tune the settings by adjusting the 

trapezoids in the Definition card.

If necessary, remove unwanted volume structures by 

using the Clip Plane or the VOI Punch function.

Change all MPR segments to 5 mm MIP Thin for better 

visualization of the coronary arteries.
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Semi-Automatic Segmentation

Activate the semi-automatic segmentation mode.

Place two end points into the ascending aorta, one 

above and one below the bifurcation of the coronary 

arteries.

Hint: If you place the seed points in the MPR segments, 

you do not need to isolate the heart in the VRT seg-

ment. Make sure you switch the MPR segments from 

5 mm MIP Thin back to standard MPR prior to placing 

the seed points as seed points cannot be placed on MIP 

Thin or MIP images.

If there are a lot of calcifications or a bypass is visible in 

the coronaries:

– Set two end points into the aorta, one above and one 

below the orifices of the coronaries.

– Set several center points after the calcifications or 

bypass directly into the coronaries.

As soon as you press the Next button, an automatic 

segmentation will be performed and keep mainly the 

coronary tree and part of the ascending aorta. After 

segmentation, the translucent mode is automatically 

switched on.

Define paths along the coronaries with two clicks for 

each path.
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Editing & Merging Paths

Following segmentation of the aorta, the resultant 

paths are shown as a list on the Measurement card.

You can edit the paths by repositioning the path points 

along the path into the center of the vessel lumen.

You can also merge paths by selecting two paths from 

the Measurement card at a time and clicking the 

Merge button.

Measurements

Select the Vessel Navigator for close-up evaluation of 

the coronary artery.

A Ribbon/Longitudinal MPR along the path is displayed.

Zoom up the MPR display to the region of interest e.g. 

a stenosis in the vessel.

You can rotate the MPR plane by using the Movie func-

tion. Choose a plane that demonstrates the tightest 

stenosis.

You can move the Focus Pointer along the vessel by 

dragging the green vertical line in the Vessel Naviga-

tor.

The axial MPR image shows the corresponding image. 

We recommend to use the axial MPR image for mea-

surements.



syngo Vessel View

139

 

The following measurements can be performed:

1.On the Vessel Navigator, vessel diameters at the 

stenosis as well as proximal and distal to the stenosis 

by placing straight distance measurements.

2.On the Vessel Navigator, length of the stenosis 

along the vessel center line by measuring the curved 

distance between the proximal and distal positions 

of the narrowing.

3.On MPR views, luminal areas at the stenosis (narrow-

est part of the vessel), proximal and distal to the 

stenosis by using the automatic contouring and area 

calculation functions.

For a more accurate evaluation, it is essential to repeat 

the measurements from a second plane, at 90° to the 

first plane. This is essential in assessing a lesion with 

non-concentric narrowing.
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Workflow for a Carotid Stenosis Case

Visualization

Use VRT settings and window settings for good visual-

ization of the carotids.

Adjust the VRT view by using presets from the VRT Gal-

lery. You can fine-tune the settings by adjusting the 

trapezoids in the Definition card.

If necessary, remove unwanted volume structures by 

using the Clip Plane or the VOI Punch function.

Semi-Automatic Segmentation

Activate the semi-automatic segmentation mode.

Place center seed points into the carotid of interest. In 

many cases, one seed point is sufficient. Place the seed 

points either in the MPR segments or in the VRT seg-

ment.

As soon as you press the Next button, an automatic 

segmentation will be performed and keep mainly the 

aortic lumen. After segmentation, the translucent 

mode is automatically switched on.

Define paths along the carotid by two clicks for each 

path.



syngo Vessel View

141

 

Editing & Merging Paths

Following segmentation of the aorta, the resultant 

paths are shown as a list on the Measurement card.

You can edit the paths by repositioning the path points 

along the path into the center of the vessel lumen.

You can also merge paths by selecting two paths from 

the Measurement card at a time and clicking the 

Merge button.

Measurements

Select the Vessel Navigator for close-up evaluation of 

the carotids.

A Ribbon/Longitudinal MPR along the path is displayed.

Zoom up the MPR display to the region of interest e.g. 

a stenosis in the vessel.

You can rotate the MPR plane by using the Movie func-

tion. Choose a plane that demonstrates the tightest 

stenosis.

You can move the Focus Pointer along the vessel by 

dragging on the green vertical line in the Vessel Navi-

gator.
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The following measurements can be performed:

1.On the Vessel Navigator, vessel diameters at the 

stenosis as well as proximal and distal to the stenosis 

by placing Straight Distance measurements.

2.On the Vessel Navigator, length of the stenosis 

along the vessel center line by measuring the curved 

distance between the proximal and distal positions 

of the narrowing.

3.On MPR views, luminal areas at the stenosis 
(narrowest part of the vessel), proximal and distal to 

the stenosis by using the automatic contouring and 

area calculation functions.
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Additional Important 
Information

Image quality

In images of poor image quality (due to strong arte-

facts or non optimal bolus timing) it might occur that 

the algorithms are not able to segment the whole 

structure.

Functions

Some functions are only available if a path is selected. 

Select a path in the path list on the Measurements 

card, if necessary. In order to increase the accuracy of 

user-defined measurements, use the Zoom/Pan func-

tion whenever possible. 

This especially helps you to identify the contours of 

very small vessels.

• To return to the original (coronal) view of the volume 

double-click anywhere on the orientation cube.

• Select Configure > Show Magnifier Window from 

the main menu to display the Magnifier Window for 

setting the seed points easier, mainly on small ves-

sels.
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• Make sure that the points for the segmentation are 

placed exactly inside the vessel. Also, do not use too 

many points; in most of the cases one seed point is 

enough depending on the vessel anatomy.

• If no image is displayed in the Vessel Navigator, sim-

ply select the path from the Measurement list again.

• You have the ability to switch back to the patient 

orthogonal orientation. This means that the MPR 

segments remain in the true orthogonal orientations 

(axial, sagittal, coronal view) as you scroll along the 

path.

• You can label paths and measurements on the Mea-

surement list.

Simply click on a selected entry and re-name it, as you 

would do in normal Windows applications.

• To improve the visibility of paths, the translucent 

mode is automatically switched on after segmenta-

tion. You can switch the translucent mode on and 

off via the right mouse button menu.

• You can modify the course of a path in the Volume or 

the MPR Segment by using the Edit entry in the con-

text sensitive menu (right mouse button).
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With the manual mode, all path points have to be set 

by you. 

– Position path points at the beginning of a vessel, 

wherever the vessel changes its course and at the 

end of the vessel.

– Position the individual path points in the most suit-

able image segment (Volume or MPR segment).

– For the identification of branched vessels, also posi-

tion a path point where the branches join.

Depending on the number as well as accuracy used in 

positioning the path points, the paths represent the 

actual course of the blood vessels.

Manual mode does not isolate the vessel tree from the 

surrounding tissue and bones. For this purpose, the 

Tube Mode may be used.

• The Tube is a clipping tool, which creates a cylindrical 

volume following the center line of the selected ves-

sel. The radius of the tube can be changed by you.
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The Tube provides a quick way to either keep the tube 

volume (= the volume around the vessel) and remove 

the surrounding structures, or to remove the tube vol-

ume and keep the surrounding structures.

Usually this only makes sense after a manual path cre-

ation, because the segmentation does a more precise 

job in separating vessel from surrounding tissue.

• Use the menu option File > Save Session to save 

intermediate results of a Vessel View session. 

Restore the session by first loading the patient 

images to Vessel View and then selecting File > 

Load Session.
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Do not delete the series VVIEW_NONIMAGE_SERIES

until you have fully completed the evaluation of your 

patient. This series contains non-image data which is 

required by the Load Session function to restore a pre-

viously interrupted session.

• After completion of a recording, the AVI files will 

automatically be stored in a directory set by the sys-

tem, e.g. H:\SiteData\VesselView\Movies.

You can review the movies by opening the File 

Browser via main menu entry Options > File Browser.

With an external PC connected, you can access your 

offline data on the external PC for post-processing.

• Select the desired files and double-click on them.

• The corresponding program, e.g. Windows Media 

Player will be opened and you can review what you 

have saved.

• Now you can send these files to floppy or burn it on 

CD.



 
Siemens AG  
Medical Solutions  
Computed Tomography 
Siemensstr. 1 
D-91301 Forchheim 
 

Siemens AG  
Wittelsbacherplatz 2 
D-80333 Muenchen 

 
Siemens AG 
Medical Solutions  
Henkestr. 127 
D-91052 Erlangen 
 
 
www.siemens.com/medical

 
 

Contact Address 
 
 
Computed Tomography 
 
 
Germany 
Telephone: +49 9191 18-0

 
 
 
Germany

Headquarters 
 
 
 
 
Germany 
Telephone: +49 9131 84-0 

© 2000-2005, Siemens AG 
Order No. 
C2-023.630.17.01.02 
Printed in Germany 
07/2005


